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Purpose and audience 

The purpose of the Health GeoLab series of guidance is to inform concerned practitioners about the 
key elements they need to be aware of when it comes to managing and using geospatial data and 
technologies in public health and guide them through the processes to be followed in that regard. 
 
The audience for this guidance includes geospatial data managers, technical advisors, and any other 
practitioners that are directly or indirectly involved in the collection and use of geospatial data and 
technologies in public health. 
 
Please note that some of the sections in the present guidance require a basic understanding of 
concepts pertaining to the use of Microsoft Excel. 

 
 
Abbreviations 
 
GIS                            Geographic Information System                                                                       
GNSS          Global Navigation Satellite System 
HGL                           Health GeoLab 
HIS          Health Information System 
MS          Microsoft 
SDG                           Sustainable Development Goal   
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1. Background 
 

The Health GeoLab (HGL) is a regional resource supporting low- and middle-income countries in Asia 
and the Pacific to fully benefit from the power of geography, geospatial data and technology to 
achieve the Sustainable Development Goals health-related (SDG 3), namely enabling healthy lives for 
all and promoting well-being for all at all ages.1 
 

The HGL uses the Health Information System (HIS) geo-enabling framework to strengthen the 
capacity of the health sector in countries related to the management and use of geospatial data and 
technologies. This document was developed as part of this approach and with the aim of being used 
by as many users as possible, including those outside Asia. 
 

This volume is part of a series of guidance that are organized as follows: 
● Part 1 - Introduction to the data-information-knowledge-decision continuum and the 

geospatial data management cycle [1] 

● Part 2 - Implementing the geospatial data management cycle: 
o 2.1 Documenting the process and defining the data needs [2] 
o 2.2 Defining the terminology, data specifications, and the ground reference [3]  
o 2.3 Compiling existing data and identifying gaps [4] 
o 2.4 Creating geospatial data 

▪ 2.4.1 Extracting vector format geospatial data from basemaps [5] 
▪ 2.4.2 Collecting data in the field [6] 

o 2.5 Cleaning, validating, and documenting the data 
▪ 2.5.1 Documenting the data using a metadata profile [7] 
▪ 2.5.2 Using advanced Microsoft Excel functions (the present document) 

o 2.6 Distributing, using, and updating the data 
▪ 2.6.1 Creating good thematic maps using desktop GIS software [8] 
▪ 2.6.2 Using thematic maps for decision making [9] 
▪ 2.6.3 Developing and implementing the appropriate data policy [10]  

 

This document is designed to evolve based on input received from users. Do not hesitate to contact 
us if you have any suggestions for improvement. 
 
The terms used in the present guidance are defined in the following glossary of terms maintained by 
the Health GeoLab: http://tinyurl.com/2dbu7ypf . 
 

Please also contact us at the same email address if you use this document as part of your activities 
and would like your institution to be recognized as one of its users. 
 
 
 
 
 

 

  

 
1 https://www.un.org/sustainabledevelopment/fr/health/ 

mailto:steeve@tropmedres.ac
mailto:steeve@tropmedres.ac
http://tinyurl.com/2dbu7ypf
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2. Introduction 
 

While most of the work done by a geospatial data manager2 is done using geospatial technology 
(Geographic Information System (GIS), Global Navigation Satellite System (GNSS), and Remote 
Sensing (RS)), several key operations must be performed in a spreadsheet. This is the case when 
creating geospatial data but more often when verifying, cleaning, or validating data compiled or 
collected in the field. 
 

Without being exhaustive, this document describes these operations and how they can be carried 
out using the advanced functions and tools of Microsoft Excel 365 3. The functions in question are 
briefly described in Annex 1 and accompanied by a link to a web page describing how to use them in 
more detail. 
 

The decimal separator used in the document is the point (.) in accordance with the ISO 80000-1 
standard. 
 

Examples based on fictitious data are provided to illustrate each of these operations and allow them 
to be practiced. These examples are accessible in the following MS Excel files: 

• Original file: http://tinyurl.com/3k7keth9  

• File with results: http://tinyurl.com/2vxcnerd  
 
 

3. Operations performed using advanced Microsoft Excel 
functions and tools 
 
The operations discussed in this section are those that will most likely be used when verifying, 
cleaning, or validating data that has been compiled or collected in the field. 
 

The steps presented here are performed on example data contained in the Excel file mentioned here 
above. 
 

 

3.1 Merge different cells’ content 
 

Information to be managed in a master list or displayed on a map may require the content of 
different cells to be merged. 
 
For example, we may need the type of health facility to be included with the name of this facility 
while these two pieces of information are stored in separate cells (name of health facility in one 
cell, type of facility health in another). 
 
Merging the two pieces of information into a single cell can be achieved using the CONCATENATE 
function. 
 
The formula used is as follows: 
 

= CONCATENATE (text 1, text 2, text 3, ...)  

 
2See Annex J of the guidelines on the use of geospatial data and technologies in immunization programs: 
https://www.unicef.org/media/58181/file  
3The functions presented here are also available in older versions of MS Excel. The way they are worded can 
nevertheless be a little different depending on the version (use of “;” instead of “,”) 

http://tinyurl.com/3k7keth9
http://tinyurl.com/2vxcnerd
https://www.unicef.org/media/58181/file
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With : 

• text 1: the first part of the text to merge. This can also be the coordinate of the cell in which 
the text is located (example: A2) 

• text 2: the second part of the text to merge. 

• text 3: the third part of the text to merge. 
 
Here is the process to be used to merge the content of two cells using the content of the “Merge 
content diff cells” worksheet from the MS Excel examples file mentioned in the introduction: 

1. Identify the columns for which you want to combine information. In this case, these are 
columns H and I (HF_Name and HF_Type ). 

2. Insert a column to the right of these columns by right clicking the column letter J and choosing 
Insert .  

  
 

3. In cell J2, use the CONCATENATE function as follows to combine the health facility name 
contained in cell H2 and the health facility type contained in cell I2 with a space in between : 

= CONCATENATE(H2," ",I2) 

  
 

4. Press the Enter key on your keyboard. This will bring up the function result for cell J2. 

 
 

5. To extend the function to the rest of column J, double-click the small square in the lower right 

corner of the cell where you entered the function ( ). This will fill the rest of the column 
with the same formula and thus the merge result (you can also click and hold the bottom right 
corner of the cell and drag it to the last row of the table). 
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6. If you want to freeze the content of the column in which you have just applied the function, 
select the column in question, copy its content, and paste it on itself using the Paste 
Special>Values from the bar function from the main menu or by right-clicking on the letter in 
column J. 

 

 
 

3.2 Disaggregate the content of a cell into separated ones  
 
Storing multiple information in a single cell (such as address, geographic coordinates, etc.) may 
prevent correct representation in a GIS software or result in poor analysis. This information should 
be captured into separate cells. This task can be performed using the Text-to-Column Conversion 
Wizard. 
 
In this example, the latitude and longitude of each record are in the same cell and will be separated 
into individual cells. 
 
Here is the process to achieve this result using the content of the “Disaggregate cell content” 
worksheet from the MS Excel examples file mentioned in the introduction: 

1. Identify the column containing the combined information and identify the character used to 
separate the information (comma, space, tab, etc.). In this example, the information is in 
column J ( Lat_Long ). In this column, the latitude and longitude of each record are separated 
by a comma. 

2. Insert three columns after the one containing the combined information ( Lat_Long ) by right-
clicking the letter of the next column ( K) and choosing Insert. Repeat this to add the second 
and third columns. 

 
 

3. Copy the content of column J ( Lat_Long ) into column K. This will ensure that you have a copy 
of the data in case you make a mistake. 
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4. Select the column with the copied data (column K ). 
5. Under the Data menu tab , click Text-to-Column in the Data Tools section.  

  
 

6. The Text-to-Column Conversion Wizard opens. In the first window, you will be asked to 
choose the file type that best describes your data. Choose Delimited because a comma 
separates latitude and longitude. Click Next.  

  
 

7. In the next window, choose Comma as separator. Verify that the expected result is obtained 
in the Data Preview part of the window. Click Next if this is the case. 
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8. In the third window: 
a. Column data format: General 
b. Destination: Select the cells in columns L and M in which the disaggregation result will 

be captured 
vs. Click Finish. 

  
 

9. When asked if you want to replace the content of the destination cells, click OK. 

  
 
This will cause the latitude and longitude of each record to appear separately in columns L 
and M. Check that this is the case. 
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10. Name the column L Lat and column M Long ..  
 

 
 

11. You can now delete column K containing information by right clicking the letter in column K 
and choosing Delete. 
 

 
 
 
 
 

3.3 Extract part of a cell’s content 
 

It is sometimes necessary to extract part of the content of a cell to place it in another cell. This task 
can be performed using the RIGHT or LEFT functions. 
 
These two functions will extract a specified number of characters from the right or left side of a 
provided text string. The formula used is as follows: 
 
   =RIGHT(text, [num_chars]) 
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  Or 

    =LEFT(text, [num_chars])   
 
With: 

• RIGHT or LEFT: The side from which the count of characters to extract will begin 

• text: The text from which to extract characters from the right or left. This can also be the 
coordinate of the cell in which the text is located (example: A2) 

• num_chars: The number of characters to extract, starting from the right or the left. Optional, 
default = 1. 

 
In the following example, we will extract from the unique identifier of each village the part 
corresponding to the unique identifier of the municipality in which they are located. 
 
The process is as follows using the content of the “Extract cell part” worksheet from the MS Excel 
examples file mentioned in the introduction: 

1. Identify the column containing the information you want to extract and the number of 
characters from the right or left you want to extract. In this example, the information is in 
column A ( Vil_Code ) and the part of the text to extract is made up of the first eight (8) 
characters from the left. 

 
2. Insert a column to the right of column ( Vil_Code ) by right-clicking the letter of column B and 

choosing Insert 

  
3. Name this new column Mun_ code . 
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4. In cell B2, enter the following formula based on the LEFT function to extract the first 8 
characters:  

=LEFT(A2,8) 

 

5. Press the Enter key on your keyboard. This will bring up the result of the LEFT function in the 
cell. 

6.  
 

7. Click and hold the small square in the lower right corner of the cell where you entered the 

function ( ) and drag the cursor down to the last row of the table. This will fill the rest 
of the column with the same formula and therefore the result for the LEFT function. 

  
 

8. To freeze the content of the column in which you have just applied the function, copy its 
content and paste it on itself using the Paste Special>Values function. 

 
 

3.4 Identify empty cells   
 
Empty cells in an MS Excel spreadsheet are not uncommon and a situation that might need to be 
corrected because these kinds of cells could mean that: 

1. The value or information is missing, perhaps because it was not collected or is not coded 
correctly. 

2. The value in the cell should be null/zero. 
3. The value or information is unknown. 

 
Regardless of the reason, these situations must be identified, and a specific value entered in the 
concerned cells to avoid any confusion or analysis error. 
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The easiest way to identify such cells in an MS Excel spreadsheet is to highlight these cells. 
 
The process is as follows using the content of the “Check for empty cells” worksheet from the MS 
Excel examples file mentioned in the introduction: 

1. Select the content of the entire table containing the empty cells to identify. 

 
 

2. In the Home tab of the menu bar, click the Conditional Formatting icon in the Styles section. 
Then choose the Highlight Cells Rules and More Rules item 

  
 

3. In the window that opens, choose the option Use a formula to determine for which cells to 
format and specify the following formula in the Format values where this formula is true field: 
=ISBLANK( A1 ) ( Note: A1 corresponds to the upper left corner of the selected table) 

  
 

4. Click on the Format button to set the color of empty cells. Red in the example here: 
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5. Click on Ok. This will make the empty cells appear in red in the table 

 
 

 

 
3.5 Identify switched latitudes and longitudes 
 
Differentiating latitude from longitude in a pair of geographic coordinates can sometimes be 
confusing, especially for people who are unfamiliar with how these pairs work. 
 
As a result, they can sometimes be switched up in a database. This must be identified and corrected 
before the data is used in a GIS software to ensure that all points are in the correct place on the map. 
 
This task can be done using the Sort function in MS Excel. 
 
Here is the process to be used to check for switched “Lat -long” spreadsheet from the MS Excel 
examples file mentioned in the introduction: 

1. Select the content of the entire table containing the geographic coordinates to analyze 
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2. Under the Data menu, click the Sort Icon in the Sort & Filter section. 

  
 

3. In the Sort dialog window that opens, check the My data has headers option. This will make 
it easier to select the column on which the sorting will be based. 

  
 

4. In the second part of the window choose: 
a. Column: Sort by Lat  
b. Sort on : Cell Values  
c. Order: Smallest to largest  

 
 

5. Click OK. This will sort the table's content by placing the smallest latitude at the top. 
6. Look at the records at the top of the table to see if any of the coordinate pairs appear 

switched. This is not the case in the example here: 

 
 

7. Look at the records at the bottom of the table to see if any pairs appear switched. This is the 
case for the last two records in the example here: 

  
 

8. Correct the inverted coordinates and save the resulting file. 
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3.6 Identify if latitudes and longitudes fall within a specific zone 
 

A quick way to check whether geographic coordinates have been correctly collected in the field 
before even using them, including in GIS software, is to identify whether they are in the 
administrative unit indicated in the master list. 
 

This task can be done using one of the following functions, each of which first requires knowing the 
minimum and maximum latitude and longitude (rectangle) of the area encompassing the 
administrative unit in question 4: 

• MIN and MAX functions 

• Sort function 

• Conditional formatting function 
 

Lat -Long Out of Area” spreadsheet in the MS Excel examples file mentioned in the introduction: 
 

Mun_Code Name_Mun LAT_MIN LAT_MAX LONG_MIN LONG_MAX 

PH139904000 Guinotaban 14.31 14.39 120.93 121.00 

PH139907000 Bilon 15.32 15.42 121.00 122.00 

 
Using the MIN and MAX functions 
 
The MIN function returns the smallest numeric value in a range of values while the MAX function 
returns the largest numeric value in that same range of values. 
 

The formulas used are as follows in the case where the coordinates are contained in cells of an MS 
Excel spreadsheet: 
 

= MIN(Cell1:Cell2) 

        And 

= MAX(Cell1:Cell2) 

With: 

• MIN or MAX : The function that specifies whether to return the smallest or largest value. 

• Cell1 : Starting cell of the range that contains the numeric values for which we want to identify 
the minimum or maximum value. 

• Cell2 : End cell of the range that contains the numeric values for which we want to identify 
the minimum or maximum value. 
 

This method does not allow each record to be analyzed separately but to identify whether one or 
more records attached to a given administrative unit are located outside this area. 
 
As each administrative unit has its own extension (minimum-maximum latitude-longitude), the 
MIN/MAX functions must be applied separately to the sets of geographic coordinates associated with 
each of these units. 
 
The following steps should be followed in this regard: 

1. Label four empty columns to the right of the table as follows: Lat_ Min , Lat_Max , Long_Min 
and Long_Max . This is where we will put the MIN/MAX formulas for latitudes and longitudes. 

 
4 For this method to be effective, you must have access to a vector format GIS layer of quality containing the 
delimitation of the administrative divisions in question. 
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2. In cell N4 (under Lat_Min ), enter the following formula based on the MIN function to identify 
the minimum latitude for all records associated with the municipality of Guinotaban : 
 

= MIN(I4:I12) 
 

 
3. Press the Enter key on your keyboard. This will bring up the result of the MIN function in the 

cell. 

   
 

4. In cell O2 (under Lat_Max ), enter the following formula based on the MAX function to identify 
the maximum latitude for all records associated with the municipality of Guinotaban : 
 

= MAX(I4:I12) 
 

    
 

5. Press the Enter key on your keyboard. This will bring up the result of the MAX function in the 
cell: 
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6. Repeat steps 2 to 5 to obtain the minimum and maximum longitude for records associated 
with the municipality of Guinotaban in cells P4 and Q4. 

 
 

7. Repeat steps 2 through 6 to obtain the minimum and maximum latitudes and longitudes for 
records associated with the Municipality of Bilon. Enter the formula in the cell: 

a. N13 for minimum latitude 
b. O13 for maximum latitude 
c. P13 for minimum longitude 
d. Q13 for maximum longitude 

 

 
 

8. Check if the minimum and maximum latitudes and longitudes obtained are within the zone 
that has been defined for each municipality: 

a. If yes, this means that all municipality records are in the area. This is the case here for 
the Municipality of Guinotaban. 

b. If no, this means that some of the municipality's records fall outside the bounding box. 
This is the case for the Municipality of Bilon because at least one of the records present 
a latitude below 15.32 and three a longitude below 121, value defined as the minimum 
latitude and longitude for this municipality  . 

9. Correct the affected records and repeat the test to ensure that all records are now in the zone 
for each of the municipalities. 

 

 
Using the Sort function: 
 
Like the MIN/MAX functions, this method does not allow you to directly identify each record that is 
outside the area that has been defined, but to identify whether at least one of the records within a 
given administrative unit is located outside the area in question. 
 
As each municipality has its minimum-maximum latitude-longitude, records are sorted by 
municipality and latitude/longitude. 
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The following steps should be followed in this regard: 
1. Select the content of the table. 

 
 

2. Under the Data menu , click the Sort Icon in the Sort & Filter section . 

  
 

3. Sort dialog window opens, check the My data has headers option at the top right. This will 
allow you to select the columns on which the sorting will be based. 

 
4. In the second part of the window choose: 

a. Column: Sort by Mun_Name 
b. Sort by: Cell Values 
c. Order: A to Z 

  
 

5. Click the Add Level button. In the second part of the window choose: 
a. Column: Sort by Lat  
b. Sort by: Cell Values 
c. Order: Smallest to largest 
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6. Click OK. This will cause the table to sort by municipality and then an increasing value for 
latitude. At this point, it may be helpful to highlight the first record for each municipality, as 
shown below, to make it easier to locate the first entry for each municipality. 

  

 

 
 

 

 

 

 

 
 

7. Note the minimum and maximum latitude values observed for each municipality. In this 
example, these values are as follows: 

Municipality Minimum latitude of step 6 Maximum latitude of step 6 

Bilon  14.42479 15.4087 

Guinotaban 14.32559 14.37597 

 
8. Check if the latitudes noted in step 7 are within the zone defined for each municipality: 

a. If yes, this means that all municipality records are in the area. This is the case here for 
the municipality of Guinotaban. 

b. If not, this means that some of the municipality's records are outside the area. This is 
the case of the Municipality of Bilon because two of the records have a latitude below 
15.32, value defined as the minimum latitude for this municipality. 

9. Repeat steps 1-8 for longitudes to identify if other records are also outside the area. This is 
the case for 3 records of the Bilon’s municipality 

10. Correct the affected records and repeat the test to ensure that all records are now in the zone 
for each of the municipalities. 
 

Using the conditional formatting feature 
 

Although a little more complicated than the previous methods, this one makes it possible to identify 
each of the records that would fall outside the zone that has been defined for each administrative 
unit. 
 
Here are the steps to follow in this regard: 

1. Select the content of the table and sort it in the same way as for the previous method 
2. Select the cells containing the latitude for the records of the Bilon Municipality (cells I48-I56). 
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3. In the Home menu tab, click Conditional Formatting in the Styles section. Choose New Rule… 
from the drop-down menu. 

   
 

4. In the window that opens, select the option Format only cells that contain. 

  
 

5. In the second part of the window (Edit the Rule Description) 
a. Keep Cell Value in first field. 
b. Use Not between in the second field. 
c. Enter the minimum and maximum values for the latitudes associated with the 

municipality of Bilon (15.32 and 15.42) 
d. Click the Format button. 

  
 

6. Click the Fill tab and choose a color that will highlight cells whose latitude is outside the range 
(red for example). Click OK . 
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7. Click OK in the New Formatting Rule window. Any latitude outside the defined range will be 
highlighted in red. This is the case for two records from the municipality of Bilon: 

 
 

8. Repeat steps 2 to 7 for the longitudes of the records associated with the municipality of Bilon, 
taking care to select the cells containing the longitudes for this municipality and entering the 
minimum and maximum longitude values for the area. As we can see this is the case for three 
records: 

 
 

9. Repeat steps 2 to 8 for the latitudes and longitudes of the municipality of Guinotaban. In this 
case, all coordinates fall in the area: 

 
 

 
3.7 Identify imprecise latitudes/longitudes 
 

The recommended level of precision for geographic coordinates is the meter [3]. To obtain this level 
of precision, the coordinates in question must have a minimum of 5 digits after the decimal separator. 
It is therefore important to identify coordinates with less digits and correct them. 
 
This task can be performed using the LEN function. 
 
Here is the process to be used to identify latitude/longitude with fewer than 5 decimal digits using 
the example reported in the “imprecise Lat-long” spreadsheet from the MS Excel example file 
mentioned in the introduction: 

1. Insert a column to the right of column I (Lat) by right clicking column J and choosing Insert. 
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2. Repeat this to add a column to the right of the column containing the longitudes (column K 

after step 1). 
3. In cell J2, use the LEN function as follows to count the number of digits to the right of the 

decimal point for the latitude contained in cell I2: 
 

= LEN(RIGHT(I2,LEN(I2)-FIND(".",I2))) 
 

  
 

4. Press the Enter key on your keyboard. This will bring up the result of the BBCAR function in 
the cell (2 in this case). 

 
 

5. To fill the rest of the column with the same formula, double-click the small square in the lower 

right corner of the cell where you entered the function ( ). You can also click and hold 
the bottom right corner of the cell and drag it to the last row in the table. 

6. Repeat steps 3 to 5 to obtain the number of digits after the decimal separator of the longitude 
of each record in column L. The formula for cell L2 would be, for example: 
 

= LEN(RIGHT(K2,LEN(K2)-FIND(".",K2))) 
 

The number of digits after the decimal point is now visible for the latitude and longitude of 
each record. You can then always either: 

• Sort the content of the entire table in ascending order by the number of digits after 
the decimal separator for latitude and then longitude. 

• Use the conditional formatting function to identify cells containing a number of digits 
lower than 5. 
 

Using the second approach will give the following result where we can see that latitude of 4 records 
and the longitude of 1 record do not have the required level of accuracy: 



25 
 

 
 
It is important to note that the 4th and 5th decimal digits in a geographic coordinate reading can be 
zeros. However, this is rarely the case for both the latitude and longitude at the same time and/or all 
numbers from the 2nd decimal place. 
 
Consequently, any geographic coordinate containing a latitude and/or longitude with only one (1) or 
two (2) decimal places should not be considered. This is for example the case of the first record in 
the table above. 
 
For other records, the best practice is to reject geographic coordinates for which both the latitude 
and longitude have less than 5 digits after the decimal separator. This is for example the case of the 
third record from the top in the table above. 
  
 

3.8 Identify duplicate records 
 
One of the most common errors encountered in tabular data is the presence of record duplicates. 
 
Identifying and then removing these duplicates is important, especially in the case of master lists. 
 
This can be done in two ways 

• Using the Conditional Formatting function 

• Using the IF and COUNTIF functions together 
 
Both options show not only duplicate records but also the first instance in which the value appeared. 
 
The next sections describe the process for these two options using the examples contained in the 
“Identify duplicates” worksheet in the MS Excel examples file mentioned in the introduction. 
 
Using Conditional Formatting 
 
The quickest way to identify duplicates is to use the conditional formatting feature. This function is a 
built-in tool in MS Excel that highlights all cells with the same values. This approach does not require 
the user to enter a formula. 
 
Here is the process to follow using the top table in the spreadsheet mentioned previously: 

1. Select the content of the entire table. 
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2. Sort the content of the table according to the column containing the information you want to 
use to identify duplicates (please refer to section 3.5 for details on how to sort). In this 
example, we will use column G containing the unique identifier of each village (Vil_Code). 
Doing this will allow the duplicates to be next to each other. 

3. Once the table is sorted, select the content of the table located in column H (Vil_Code) 

 
4. Under the Home menu, click Conditional Formatting in the Styles section and then click Cell 

Highlighting Rules in the first drop-down menu, and then choose Duplicate Values in the 
second 
 

  
 

5. The Duplicate Values dialog box opens and the cells containing the duplicates are directly 
highlighted in light red with dark red text. Click OK to accept the default. 
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Using the IF and COUNTIF functions 
 
The combination of IF and COUNTIF functions can also be used together to identify duplicates in a 
particular column. More precisely: 

• The COUNTIF function is used to identify if given information appears more than once among 
the selected records 

• The IF function itself is used to highlight cells containing information appearing multiple times. 
 
The formula used based on these two functions to identify duplicates is as follows: 
 
  = IF( COUNTIF ( range, criteria )>1,"Duplicate","") 
With: 

• range: The set of cells for which we are trying to identify duplicates. In this example, this 
corresponds to the cells containing the unique identifier of each village. 

• criteria: The value we analyze in the range. This corresponds here to the unique identifier of 
the village for the record on which the formula is applied. 

• >1: The condition to which the COUNTIF result must conform for the IF function to return “ 
Duplicate” in the cell. If this condition is not met, the IF function will return an empty cell. 

 
Here is the process to follow using the bottom table in the spreadsheet mentioned previously: 

1. Select the entire content of the table. 

  
2. Sort the content of the table according to the column containing the information you want to 

use to identify duplicates (please refer to section 3.5 for details on how to sort). In this 
example we will use column G containing the unique identifier of each village (Vil_Code ). 
Doing this will allow the duplicates to be next to each other. 
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3. Insert cells to the right of those containing the unique identifier of each village by selecting 
the cells (not the column) containing the Vil_Name field and those containing the name of 
each village, then right-clicking and choosing Insert. In the window that opens choose the 
option Shift cells right. 

4. In cell H29, enter the following formula based on the IF and COUNTIF functions (using the 
“$” sign in front of the character and cell number will freeze the formula on that range of 
cells when copying the formula in other cells): 
 
 

=IF(COUNTIF($G$29:$G$48,G29)>1,"Duplicate", "") 
 

 
 

5. Press the Enter key on your keyboard. This will execute the formula and return the results of 
the function. 

6. Double-click the small square in the lower right corner of the cell where you entered the 

function ( ). This will fill the rest of the column with the same formula (or click and 
hold on the bottom right corner of the cell and drag to the last row of the table). The word " 
Duplicate " will now appear to the right of each record for which one or more unique identifier 
duplicates exist. 

 

 
 

3.9 Join the content of one table to another 
 
Data you may want to have in a single table can sometimes be stored in different tables. If the tables 
in question contain the same unique identifier for each record, then it is possible to join their content. 
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This task can be performed using the VLOOKUP function. This function is called via the following 
formula: 
 

= VLOOKUP (search_value,matrix_table,col_index_no,[near_value]) 
 
With: 

• searched_value : Value you want to search for. 

• Table_matrix : Range of cells in which the VLOOKUP function will search for the 
search_value argument and the return value. 

• no _index_col : Column number which contains the return value (the leftmost column of 
the matrix_table corresponding to 1). 

• Close_value : [optional] Represents a logical value indicating whether you want the 
VLOOKUP function to search for an exact or an approximate match. TRUE = approximate 
match (default). FALSE = exact match. 

 
In the example used here, we will use this function to attach the population of the villages to the 
other information contained in the master list of villages. 
 
Here is the process to use to achieve this result using the contents of the “Join tables” worksheet 
from the MS Excel examples file mentioned in the introduction: 

1. Label the column to the right of the Long column in the left table (master list (primary table)) 
Pop_2010. 

  
2. In cell K4, enter the following formula based on the VLOOKUP function: 

 
=VLOOKUP(G4,P:Q,2,FALSE)  
 

What this formula allows you to do is take the value contained in cell G4 (PH139907003) and 
see if this value is found in the first column of the range made up of columns P and Q (P:Q). 

• If this is the case, the value contained in the second column of the range (column Q) 
will be reported in cell K4 

• If it is not, #N/A (FALSE) will be indicated in cell K4 
 
In the present case, the value PH139907003 is indeed in column P: 

 
3. By pressing the Enter key on your keyboard, the value associated with the unique identifier 

PH139907003 in column Q will appear in cell K4: 
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4. Double-click the small square in the lower right corner of the cell where you entered the 

function ( ). This will fill the rest of the column with the same formula and thus the 
VLOOKUP result (or click and hold on the bottom right corner of the cell and drag to the last 
row of the table). 

  
 

Note: the XLOOKUP function allows to do the same as what is presented here above but with more 
flexibility than the VLOOKUP function as it allows to search in any direction (left or right) and defaults 
to an exact match, while VLOOKUP primarily searches right from the leftmost column and requires 
an explicit setting for exact matches. Please refer to the webpage mentioned in Annex 1 for more 
details about this function 

 
3.10 Check completeness against the master list 
 

The process, and therefore the same function as described in section 3.9 (VLOOKUP), can also be 
used to check whether a table contains all the geographic features reported in the corresponding 
master list 5. This test is important to ensure the completeness of your data set. 
 

In this example, we will check if the table containing the number of cases per village contains all the 
villages reported in the master list. This example is included in the “Verify exhaustivity” worksheet in 
the MS Excel Examples file mentioned in the introduction: 
 

1. Label one of the columns next to column H ( Vil_Name ) of the master list as 
Ver_Completeness 
  

 
 

2. In cell J5, enter the following formula based on the VLOOKUP function: 
 

=VLOOKUP(G5,N:O,2,FALSE) 

 
5 Single, authoritative list maintained by the officially mandated agency, complete, up-to-date and uniquely encoded of 

all active (and past) records for a type of entity/geographic object (e.g. health facilities, divisions administrative, 
villages) 
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 What this formula allows you to do is take the value contained in cell G5 (PH139904003) and 
see if this value is found in the first column of the range made up of columns N and O (N:O). 

• If this is the case, the value contained in the second column of the range (column O) 
will be reported in cell J5 

• If it is not, #N/A (FALSE) will be indicated in cell J5 
 

In this case, the value PH139904003 is indeed in column N: 

 
 

3. By pressing the Enter key on your keyboard, the value associated with the unique identifier 
PH139904003 in column O will appear in cell J5: 
 

 
 
 

4. Click and hold the small square in the lower right corner of the cell where you entered the 

function ( ) and drag the cursor down to the last row of the table. This will fill the rest 
of the column with the same formula and the VLOOKUP result. 

  
 

The value “#N/A” in the Ver_Completeness column indicates records in the master list for which there 
is no value in the table containing the number of cases. 
 

This is the case of two villages in this example (Linao and Marayag ). The table of the number of cases 
at the village level is therefore incomplete compared to the master list. 
 

It is important to note that to be valid this test must be carried out based on the master list having 
the same temporal validity as the programmatic data (number of cases per village in the present 
case). In other words, if programmatic data captures the number of cases in villages for January 2023, 
the master list of villages to be used should be representative of the situation observed for that same 
month. If this is not the case, the identified difference may be due to actual changes that occurred 
between the time the master list was last updated and the programmatic data collected. 
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3.11 Identify differences of content between two columns 
 
Identifying potential differences of content between two columns, especially after performing a join 
using the VLOOKUP function, helps ensure consistency between different tables. Such identification 
is carried out using the IF function. 
 
In this example, we will check if the spelling of the name of the village indicated in the table of cases 
per village used in section 3.9 matches the official spelling indicated in the master list of villages. 
 
Here is the process to use to compare the content of these two columns using the example included 
in the “Verify exhaustivity” worksheet in the MS Excel examples file mentioned in the introduction: 

1. Label one of the columns next to the Ver_completeness column from the master list Ver_ 
content. 

  
 
 
 

2. In cell L5, enter the following formula based on the IF function: 
 

= IF(J5=H5,"","Different") 
 

3. Press the Enter key on your keyboard. This will run the IF function which will test if the 
content of cell J5 is the same or different from the content of cell H5. If so, the function will 
return “ ” (empty cell). Otherwise, the text “Different” will appear in the cell. 

4. Click and hold the small square in the lower right corner of the cell where you entered the 

function ( ) and drag the cursor down to the last row of the table. This will fill the rest 
of the column with the same formula and therefore the result of the IF-based formula. 

 
 

In the present case, we can observe that the use of the IF function returned: 

• A blank cell for most villages meaning that, in these cases, the spelling of the village name 
contained in the number of cases table matches the spelling contained in the master list. 

• The “Different” text for a record. In this case, the spelling of the name of the village in the 
table of case numbers ( Bacolud ) is different from that reported in the master list (Bacolod) 

• #N/A for the two villages that are in the master list but not in the case count table. 
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3.12 Summarize the content of a given column 
 
It is sometimes useful to check whether the number of geographic features in an administrative unit 
is correct or to calculate how many of these features are of a certain type according to a predefined 
classification and place this information in a table. 
 
This task can be done using the PivotTable tool in MS Excel. 
 
In this example, we will count how many villages are in each of the municipalities included in the 
example reported in the “Summary column content” worksheet of the MS Excel examples file 
mentioned in the introduction: 

1. Select the column, or range, containing the information to summarize. In this case, it is the 
cells containing either the name or the unique identifier of the municipalities (Mun_code or 
Mun_Name ) because the table contains the list of villages for each municipality. By 
calculating the number of records per municipality we will indirectly obtain the number of 
villages in each of them. 
 

 
2. Under the Insert menu, click on the Pivot Table icon in the Tables section 

 
3. In the window that opens 

a. Table/Range: keep the information as such (column you selected ) 
b. Choose where you want to place the pivot table: choose the Existing Worksheet option 
c. Location: click in the field then on cell M1 in the spreadsheet 
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4. Click OK. This will bring up the pivot table in the worksheet and the panel for this tool on the 
right 

 
 

5. In this panel: 
a. Check the Mun_Code box in the top window. This will make this field appear in the 

Row area at the bottom left. 
b. Right click on Mun_Code In the top window, hold click and drag to the Values box in 

the bottom right area. 

 
 

6. Check that the parameter for the value field is “Count” as is the case in the example above. If 

not, click on the small triangle to the right of the field  and select the Value 

Field Settings option. . In the window that opens, select the 
Count option and click OK 

  
 

7. Click in the spreadsheet to see the resulting pivot table 
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As we can see there are 9 registrations, and therefore villages, in each municipaly. 
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3.13 Aggregate the content of a given column 
 
The values you are working with may sometimes need to be aggregated to be represented on a map 
at a different level of the administrative structure for example (e.g. province instead of district). 
 
This task can also be done using the PivotTable tool. 
 
We will aggregate the population by village at the municipality level for the year 2010 using the 
example reported in the “Aggregate column content” worksheet of the MS Excel examples file 
mentioned in the introduction: 

1. Select columns E to K in the spreadsheet (we will use the unique identifier of each municipality 
in the summary table because this will facilitate joining with other tables (see section 3.9) or 
the corresponding GIS layer). 

 
8. Under the Insert menu, click on the Pivot Table icon in the Tables section 

 
9. In the window that opens 

a. Table/Range: keep the information as is (range you selected) 
b. Choose where you want to place the pivot table: choose the Existing Worksheet option 
c. Location: click in the field then on cell M1 in the spreadsheet 

 
 

2. Click OK. This will bring up the pivot table in the worksheet and the panel for this tool on the 
right 
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3. In the panel: 
a. Check the Mun_Code box in the top window. This will make this field appear in the 

Row area at the bottom left. 
b. Right-click on Pop_2010 in the top window, hold and drag to the Values box in the 

bottom right area. 

 
4. Check that the parameter for the value field is “Sum” as is the case in the example above. If 

not, click on the small triangle to the right of the field and select the 

Value Field Settings option. . In the window that opens, select 
the Sum option and click OK 

  
 

5. Click in the spreadsheet to see the resulting pivot table 
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3.14 Check for data consistency between records 
 
One of the things to avoid in a table is inconsistencies between records concerning data elements 
based on a classification table (example: types of health facilities, ownership, names of administrative 
units…). 
 
Checking consistency between these records can be done using the PivotTable tool. 
 
In this example we will check if the health facility types (HF_Type column) are consistent between all 
the records in the table reported in the “Verify consistency” spreadsheet of the MS Excel example 
file mentioned in the introduction: 

1. Select the column I that contains the health facility types (HF_Type). 
 

 
 

2. Under the Insert menu, click on the Pivot Table icon in the Tables section 

 
3. In the window that opens 

a. Table/Range: keep the information as such (column you selected) 
b. Choose where you want to place the pivot table: choose the Existing Worksheet option 
c. Location: click in the field then on cell M1 in the spreadsheet 
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4. Click OK. This will bring up the pivot table in the worksheet and the panel for this tool on the 
right 

 
 

5. In the panel: 
a. Check the HF_Type box in the top window. This will make this field appear in the Row 

area at the bottom left. 
b. Right click on HF_Type In the top window, hold click and drag to the Values box in the 

bottom right area. 

  
6. Check that the parameter for the value field is “Count” as is the case in the example above. If 

not, click on the small triangle to the right of the field and select the 

Value Field Settings option. . In the window that opens, select 
the Number option and click OK 

   
 

7. Click in the spreadsheet to see the resulting pivot table 
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Several inconsistencies can be noted: 

• The Barangay Health Station type is captured in its abbreviation form (BHS) for 4 of the 
records. 

• The same is true for the Rural Health Unit type which presents a record for which the 
information is captured by an abbreviation (RHU). 
 

The information for these records should be corrected based on the corresponding classification 
table to allow consistent use. 
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Annex 1 – MS Excel functions/tools used in this guide 
 

Function/tools brief description Web site 

CONCATENATE 
Combines text from multiple 
ranges and/or strings 

http://tinyurl.com/3h7nv6ud  

FILTER 
Allows you to filter a range of data 
based on criteria you define 

http://tinyurl.com/mr2skb8v 

LEFT / RIGHT 

Returns the last character(s) of a 
text string, based on the number of 
characters specified from either 
side 

http://tinyurl.com/5n7s67nt / 
http://tinyurl.com/2w3v2e44  

MIN 
Returns the smallest numeric value 
in a range of values. 

http://tinyurl.com/yjjen9yb  

MAX 
Returns the largest numeric value 
in a range of values. 

http://tinyurl.com/4sfwhs8k  

LEN 
Returns the number of characters 
contained in a text string. 

http://tinyurl.com/2s39kbn6  

COUNTIF 
Allows you to count the number of 
cells that meet a criterion 

http://tinyurl.com/3jmadh2b  

VLOOKUP 
Find items in a table or range by 
row 

http://tinyurl.com/5azjk28k  

XLOOKUP 
Find items in a table or range by 
row and this in any direction 

https://tinyurl.com/mr3a9a9t  

SORT 
Sorts the content of a range or 
table 

http://tinyurl.com/4prf92h7  

IF 
Allows you to make logical 
comparisons between a value and 
the expected result 

http://tinyurl.com/3ccswt5u  

Conditional 
formatting 

Highlight cells with color using 
rules you set based on the values 
in those cells. 

http://tinyurl.com/3ucxubyc  

Pivot table 
Tool capable of calculating, 
synthesizing and analyzing data in 
tabular form 

http://tinyurl.com/y3rdu96k  

Text-to-Column 
wizard  

Retrieves and redistributes text in 
several cells, text from one or more 
cells 

http://tinyurl.com/5n8jmtma  
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